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This Month’s June Meetings 
 

General Meeting 
Tuesday, June 11th at 6:00 P.M. 
At Christ Lutheran Church FFG 

 
Plateau Photography Club Workshop 

Thursday June 20th at 1:00 P.M.  
At FFG Library Bldg. 
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The June 11th Program at  6:00 P.M. 
FFG Christ Lutheran Church 

 

Microsoft Windows 10 version 1903 

Carl Nordeen, past president of PPCUG, will 
give this month’s presentation. 

Windows 10 version 1903 has just, been re-
leased which was internally codenamed 19H1, 
and brings a compelling mix of new features 
and smaller refinements, including a completely 
new light theme. 

This new visual style also includes redesigned 
icons for the taskbar, as well as new elements 
that provide the operating system with an over-
all more modern look and feel.  

The presentation will be about, these changes 
and whether or not they are beneficial to the 
users. 

 

 

 

Winter Hours  start at 3:00 P.M. (October through March) 
Summer Hours start at 6:00 P.M. (April through September) 
 
Location:  Christ Lutheran Church 

481 Snead Drive, Fairfield Glade TN 

mailto:www.PPCUGinc.com
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Join the Club! 
Anyone interested to attend the general meeting or any of the 
SIG meetings as a guest will be charged $3.00 per person for 
any or all meetings in that month. Afterwards, you are en-
couraged to become a member of the Plateau PC Users 
Group.  
Our Club cannot exist without you, the members.  
  
Membership Dues  

Our annual dues are now payable July 1st of each year.   
Annual dues are $24 per single person / $30 per family  
starting July 1, 2014.with partial years dues as follows: 

  
 
 

 
 
 
 
 
 
 

Student memberships (21 and under) are $10 annually.   
Corporate memberships are $30 a year for the first two  
memberships and $10  a year for each additional  
membership from the same company.   
Contact the PPCUG Treasurer (931) 707-3677  
for pro-rated dues of these types of memberships. 
 

BOARD OF DIRECTORS DISCLAIMER 
 

All members of the Plateau PC Users Group are willing to 
help one another in the area of advice and tutorial instruc-
tion over the phone.  If you should require more involved 
services or instruction, we have a few members who are 
very knowledgeable in several areas.  As a responsible  
consumer, it is up to you to discuss, before retaining a mem-
ber, any and ALL charges for repair services and time con-
suming tutorial activities. 
 
It is not the desire of this Board of Directors to set fees for 
individuals for services rendered, nor the responsibility to 
intervene between members who enter into a contract 
among themselves. 
 
The GAZETTE is published using the following:  Microsoft 
Word, Microsoft Publisher, and Microsoft Windows.  The 
Gazette is the monthly newsletter of the Plateau PC Users 
Group, Inc. 
 
DISCLAIMER:  No warranty, express or implied, is made 
by the PPCUG, the Gazette editorial staff or its contributing 
editors.  This extends to all losses incidental or consequen-
tial from the use or non-use of any information in any issue 
of the Gazette. 
 
All images used in the newsletter, website, blogs, class mate-
rials or handouts (“media”)  are obtained from a “free use” 
source, preferably images that have been released as “CCO 
Public Domain”. 

 
2018-2019 PPCUG, Inc. Board Members 

President Steve Rosenstein (931) 742-0151 

Vice-President/  
Compliance  

Jim Buxton (931) 456-6009  

Treasurer John Krueger (931) 707-3677 

Acting Secretary Linda Yates (619) 807-1616 

Past President Carl Nordeen  (931) 456-5597 

Membership John Krueger (931) 707-3677 

Publicity Mary Anne Nordeen  (931) 456-5597 

Gazette Editor Gordon Botting (931) 456-2184 

APCUG Rep  Steve Rosenstein (931) 742-0151 

Equipment  
Custodian 

 Bob Willis (931) 456-6511 

Webmaster Alan Baker  (931) 239-0877 

   

Directors at Large 

Gordon Botting Richard Del Frate Barbara Duncan 

Bob Willis Charlie Merrick Frank Wade 

   

 

    

 SIG Leader   

Plateau Photography 
Club Workshop 

Jim Gries 
 

FGphotography-
club@gmail.com 
(331) 442-9763 

   

 
Join In 

Jul-Sep  
Annual 

Dues 

Oct-Dec  Jan-Mar Apr-Jun 

Single: $24 $18 $12 $6 

Families: 
$30 $22 $15 $7 
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Up Coming Meeting for July 9, 2019 
 

Note: Change to Summer Hours  
 

The next General Meeting of the 
PLATEAU PC USERS GROUP 

Will be on Tuesday, July 9th at 6:00 P.M. 
at Christ  Lutheran Church 

481 Snead Drive FFG 
(corner of Snead & Lakeview Drive) 

 

Cool Tips & Sites 

 

Ten OneNote Keyboard Shortcuts 

If you are already taking advantage of the pow-
er and flexibility of OneNote (see page #4), try 
these useful keyboard shortcuts: 

· Check spelling: [F7] 

· Add current date: [Alt] + [Shift] + D 

· Add current time:  [Alt] + [Shift] + T 

· Add current date and time:  [Alt] + 
[Shift] + F 

· Insert a hyperlink: [Ctrl] + K 

· Add a new page at the end of the cur-
rent section: [Ctrl] + N 

· Add a new page under current page at 
same level of indentation: [Ctrl] + [Alt] 
+ N 

· Add a new subpage under current page 
at same level of indentation: 
[Ctrl] + [Alt] + [Shift] + N 

· Apply, mark, or clear To Do tag: [Ctrl] 
+ 1 

· Send selected pages to an email mes-
sage: [Ctrl] + [Shift] + E 

 
 

 
News of the Special Interest Groups 

 

Plateau Photography Club 
  
In June 2018, the Plateau Photography and the Photo  
Editing Workshop Groups merged their monthly meetings 
into one meeting to be held on the third Thursday of each 
month, except for the months of December and February 
downstairs at the Fairfield Glade Library building (formerly 
the Multi-Purpose building), Room C, at 455 Lakeview 
Drive next to the swimming pool area. Enter the lower level 
from outside below the deck in back.  
  
Members of the PPCUG may attend at no charge; guests 
are asked to pay $3 for these workshops (the $3 fee is good 
for all meetings and workshops in the month paid). 
 
As more people take digital pictures, photo editing has be-
come a necessary and essential part of producing the final 
picture. Since over 95% percent of all pictures taken today 
are photo edited in some way, it was felt that the two topics 
should be combined in our meetings. 
  
The meetings will have monthly assignments covering a 
various categories.  Each member will be asked to bring the 
original picture taken and then explain the photo editing 
tools used to produce the final picture.  There will be dis-
cussion covering the picture itself and the tools used and 
why they were used.  Pictures with no photo editing are  
also welcomed. 
  
Each meeting will try to include short presentations on  
photography practices and/or photo editing techniques.   
 
The topics and assignments will be published in advanced 
to allow enough time for each member to plan and carry out 
their assignments.   The SIG leader is Jim Gries. at  
FGPhotographyclub@gmail.com 
  
 

 ** New look for PPCUG Website ** 
 

Visit our website at www.PPCUGinc.com. The 
Learning Center class schedule and Gazette are 
all available on our web site. 
 
Send your comments and suggestions to the  
Webmaster, Alan Baker 
Webmaster@ppcuginc.com  (931) 239-0877 
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Vote for PPCUG Officers Election in June 2019 

  

(For the period July 2019 though June 2020) 
  
Suggested candidates slated for PPCUG 

Board include: 
  
President: Steve Rosenstein 
Vice President & Compliance: Jim Buxton 
Treasurer: John Krueger 
Secretary: Linda Yates 
Past President: Carl Nordeen 
  
Directors at Large:  
  Gordon Botting   
 Barbara Duncan 
  Richard Del Frate 
  Bob Willis  

  Charlie Merrick 
  Frank Wade 

******************** 

Tuesday, June  11th Meeting  

OneNote: The “Secret” Microsoft Office Program 

Much of the data you work with each day probably gets stored electronically in some way: you save appoint-
ments, meetings, and contacts in Outlook and you likely manage lists and other key data in an Excel worksheet 

or Word table. How do you handle the stacks of data that doesn’t fit into the most pop-
ular Microsoft Office programs? What’s the best way to handle notes from meetings, 
brainstorming sessions, classes, project planning, Post-It notes pasted to your monitor, 
important hand-written text, and “where do I store this?” nuggets. How can you search 
this collection of notes and content? Try OneNote. 

 

OneNote is a place to create, gather, store, and search notes. A note can be almost any-
thing you want it to be—a typed line of text, a sketch, an audio or video clip, a picture, 
a link to a web page or file—you get the idea. Even if you have never heard of One-

Note or used it before, it’s likely hanging out on your computer just waiting for you to discover this “secret” 
Microsoft Office tool. 

Using Notebooks 

 

In OneNote, you use different containers to define the organizational levels, with the top-level container being 
the notebook. The different types of OneNote “information containers” are:  

(Continued on page 5) 
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· Notebook: The physical notebooks in your work area probably include color-coded tabs to divide the 
notebook into separate sections or topics, each with its own collection of pages. OneNote uses the same 
idea but with virtual folders called notebooks with a series of color-coded tabs or sections, each section 
made up of one or more pages. Pages are where you write, doodle, and paste in your notes. For further 
organization, you can even create subpages with additional information under the same title as its corre-
sponding page. 

· Section: This is a tabbed divider that enables you to group pages related to a particular topic or project 
phase. Each section provides separation in the notebook and serves as the main topical level in the note-
book’s hierarchy. 

· Section Group: A group enables you to place associated sections together. This is particularly use-
ful when a notebook contains many sections. Section groups are optional.  

· Page: You place your notes and other items on the notebook pages. The Page Tabs pane lists pages in a 
selected section. 

· Subpage: The subpage is the lowest level in the notebook’s structure and helps break up information 
normally placed on a single page. 

·  
Creating a New Notebook 
 
OneNote includes sample notebooks to highlight OneNote features. Rather than trying to modify this existing 
notebook, you’ll want to create your own. Although the interface varies with your version of Microsoft Office, 
in OneNote 2016, OneNote 2013, and OneNote 2010, you create a new notebook with File > New. Most of the 
options are fairly clear but make sure to watch closely when you choose how you want to use the notebook: on 
your computer, the Web, within your OneDrive account, in Sharepoint, or a network. A OneNote notebook 
might be just for your own use or shared by a group or team. You can even send out an e-mail to others with 
notebook-sharing information. 
 
Organizing Notebook Information with Sections 

In keeping with the virtual idea of a functional notebook, it’s important to impose some kind of order on all 
these pieces of information. Within each notebook, the second level of organization is the section, which is rep-
resented by a tab along the top of the notebook. You can use the sections to organize the notebook’s topic or 
theme into smaller subjects. You can create as many sections as you need although it may be harder to read 
each tab name as the number of sections grows. To create a new section, click on the + tab or Create a New 
Section tab (var ies by version), or right -click an existing section and choose New Section. 

Take OneNote for a Test Drive! 

If you have access to OneNote, launch the program and take it for a tour. Dig into the sample notebook and cre-
ate one of your own (you can always delete it later). Other features to explore in OneNote: 

· Move sections from one part of a notebook to another or even to a different notebook. 

· Apply color-coding to notebooks and sections. 

· Experiment by adding links to websites and documents, creating free hand text, inserting images and 
pictures, and adding video and audio. 

· Tip: One surprise in OneNote is that, unlike other Microsoft Office work, notebooks are automat-
ically saved and are all loaded when you re-start the program. 

 
See for yourself how OneNote can help you further organize your office, school, or home life.  

 

(Continued from page 4) 
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Goodbye to Microsoft Windows 7 & Office 2010 
 

In 2018, Microsoft announced the End of Life for Microsoft Office 2010 and Microsoft Windows 7. The 
countdown clock has started on this popular desktop configuration as the deadlines for extended support on 
these two products are January 14, 2020 for Windows 7 and October 13, 2020 for Office 2010. 
  
 

What Does the End of Life for Office 2010 & Windows 7 Mean to You? 

Although you may be perfectly happy with your Windows 7 computer running Office 2010, these are old pro-
grams—especially in the world of software. Although Windows 7, launched on July 22, 2009, is a decade old 
at this point, it’s still incredibly popular. Recent reports from Netmarketshare suggest that Windows 7 is still 
being used on 39% of all PCs. 

Even so, it's time to seriously look at upgrading because when these programs reach their end of support,  

Microsoft will no longer provide: 

· Technical support 

· Bug fixes for issues that are discovered 

· Security fixes for vulnerabilities that are exposed 

 
 
 
 
 
 
 
 
 
 

2018 – Edge browser 
 

Microsoft is rebuilding its Edge browser on Chrome and bringing it to the Mac 
 
Microsoft announced some significant changes to its Edge browser. The software giant is beginning to  
rebuild Microsoft Edge to run on Chromium, the same open-source web rendering engine that powers  
Google’s Chrome browser. 
 
So why is Microsoft changing its rendering engine? Why now? Edge has fallen massively behind Chrome in 
terms of market share. Developers are optimizing for Chrome, and Google has also been creating Chrome-only 
web services because it’s often the first to adopt emerging web technologies. Microsoft has struggled to keep 
its Edge rendering engine in stride with Chromium. 
  
Microsoft Edge isn’t going away, nor is the brand name. If you already use Edge on Windows, then that won’t 
change. All you’ll ultimately notice is that websites will render more consistently once Microsoft makes this 
under-the-hood change. 
 
Chris Welsh, The Verge -  http://bit.ly/2P0KKCa    
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Microsoft Word Tricks: 3 Simple Ways to Keep Text Together 
 

Most of the time, we want text in a Microsoft Word document to automatically wrap, that is, to move to the 
next line when it is too long to fit on one line. Word wrap is great except when it breaks up text we want to stay 
together such as dates, names, phone numbers, phrases, formulas, titles or other text that should remain together 
on the same line. Fortunately, Word has some easy ways to keep text together. 
 
Some examples of text you might want to keep together and not break up on separate lines: 
 

· September 2, 2018 
· Christopher A. Jones, Ph.D. 
· (555) 123-4567 
· state-of-the-art 

Your options for keeping text together in Microsoft Word include: 
 

· Non-breaking spaces 
· Non-breaking hyphens 
· Non-breaking paragraphs & lines 
 

Non-Breaking Spaces & Non-Breaking Hyphens 
 
The common solution: what most people do to keep text together is move to the beginning of the text and press 
[Enter] to start a new line. This is fine until any of the text changes and causes breaks in the wrong place. 
Now you’re wasting time going back to remove these extra lines when you no longer need the forced break to 
the text. And, this manual approach doesn’t work well if you have paragraph formatting or styles that adds 
space between paragraphs. 
 
The right solution: keep text together with special characters. Specifically, delete the spaces or hyphens and re-
place normal spaces and hyphens with non-breaking spaces or non-breaking hyphens: 
 

· Non-breaking space: [Ctrl] + [Shift] + [Spacebar] 
· Non-breaking hyphen: [Ctrl] + [Shift] + [Hyphen] 
 

As the name implies, non-breaking characters connect the text together and the entire phrase or group of  
characters will all automatically move to the next line together but only as needed.  
 
To view non-breaking space and hyphen characters in a document, click Show/Hide in the Paragraph group 
(Home tab). Word represents non-breaking space characters with a degree symbol (°) and non-breaking  
hyphen characters with a double-length hyphen (these are a bit harder to distinguish from regular text) 
. 
Non-Breaking Paragraphs and Lines 
 
Next, let’s go one step further. When you don’t want a paragraph or even several lines of text to break between 
two pages, don’t press multiple [Enter] keys to move text to the next page. Instead, try the following Word  
techniques to keep text automatically together: 
 

1. Select the paragraph or section of text you want to keep together. 
2. On the Home tab in Word, click the Paragraph group’s dialog launcher (the small arrow at the bottom-

right of the group). 
3. Pick the Line and Page Breaks 
4. Check the Keep lines together option, and click OK. 

(Continued on page 8) 
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5. If you have multiple paragraphs selected, for instance, a title with following text, also click on Keep 
with next which will keep the paragraphs together on the same page.  
 

Bonus Word Tricks 
 
To find non-breaking spaces and non-breaking hyphens in your text, use the Find feature as follows: 

1. On the Home tab, click the Find icon in the Editing group on the right or press the keyboard shortcut 
[Ctrl] + F. 

2. In the Navigation Pane to the left, enter one of the following: ŝ to find non-breaking space; ^~ to find 
non-breaking hyphens. 

3. Use the Navigation Pane to move through the results. 
 

Make sure you have the Show/Hide non-printing characters features turned on so you can see the hidden  
characters for these non-breaking symbols. 
 

Microsoft Outlook 2013:  
Top 10 New Features in Outlook 2013 

 
Are you ready to upgrade to the latest version of the most popular email program? Let’s look at a sapling of the 
Microsoft Outlook 2013 new features and improvements. 

 

 

 

1. A New Look for Outlook 

As with other Microsoft Office 2013 programs, the interface has been remodeled. The Ribbon and icons are 
flatter in appearance and the color scheme choices have shifted to white, light gray, or dark gray; not a visual 
improvement in my eyes. At least you can dress Outlook up with a choice of themed backgrounds (Calligraphy, 
Clouds, Circuit, Stars, etc.). 

2. Attachment Reminder 

When you use words or phrases in a message related to an attachment such as “attached”, “attachment”, 
“attaching”, “enclosed”, “sending you”, Outlook detects if you mentioned an attachment and forgot to include it 
in the email. This is only triggered if the context of the message makes sense. With this small but handy new 
feature, there is no need to send a second email and say “Oops! Here is the attachment I forgot to send you.” 

3. Message Preview 

Know at a glance, which messages to read and handle first with the Message Preview feature (accessible from 
the View tab) which displays one, two, or three lines of the message body right inside the Inbox. A great way to 
scan messages without having to open each message individually. 

4. Quick Actions in Message List 

Flag, delete, or mark your messages read or unread with handy commands in the message list.  

5. One-Click Unread Mail Filter 

Unless you diligently practice Zero Inbox, your Inbox is likely full of read and unread messages alike. In Out-
look 2010, it took several steps to view only unread mail. Now in Outlook 2013, there’s a big easy-to-spot Un-
read button right at the top of your Inbox. Click it and you will quickly only see messages marked as  

(Continued from page 7) 
 

(Continued on page 9) 
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unread. Want to go back to the full Inbox view? Just click the All option right next to it. A great productivity 
improvement! 

6. New Reading Pane Features       

As with earlier versions of Outlook, an optional Reading Pane can be displayed at the right or bottom of your 
Inbox. Outlook 2013 introduces several nice improvements to this view. 

Inline Reply 

When the Reading Pane is displayed in the Inbox, you can now reply to or forward an email with one click right 
in that pane without needing to open the message. This feature lets you directly start writing your reply in the 
Reading Pane (which means that it is not really just a Reading Pane anymore). And if you change your mind 
and want to view your response in a new window and use additional formatting options, just click on the Pop 
Out option. 

Zoom Slider 

Depending on how an email is formatted or the size/resolution of your screen, the text might be too small to 
read comfortably or even too large for the confines of the Reading Pane. Outlook 2013 brings over a great fea-
ture from Word: the Zoom slider. Displayed in the lower-right corner of the Reading Pane, it lets you make 
quick and easy adjustments to the zoom level for the message you are viewing. 

A handy feature but, unfortunately, the setting doesn’t carry over to other messages in your Inbox, and if you 
click away from one zoomed email and click back to it, your zoom setting is lost.  

7. Customize Your Folders 

In earlier versions of Outlook, we had to use naming schemes, such as adding punctuation symbols at the begin-
ning (@Important, *Key Clients), to alphabetize folder names. In Outlook 2013, you can now drag folders into 
any order so your most important ones are visible near the top. Change your mind? You can change back to al-
phabetical order with just a few clicks. Of all of the Outlook 2013 new features, this is my favorite and most 
useful. 

8. Sneak a Peek 

Hover your mouse over Outlook’s navigation buttons/options to grab a quick glance at your schedule, an ap-
pointment, or details about someone you’re emailing while minimizing the need to switch tabs. 

9. People Card 

The new People Card automatically consolidates contact information from numerous sources and displays their 
latest social activity from Facebook and LinkedIn. You can quickly see contact information and reach out to 
contacts directly from the Inbox and anywhere in Outlook 2013. From the card, you can schedule a meeting, 
send an instant message, or give them a call, making it a one-stop shop for all communication. 

10. Weather Bar 

The Weather Bar addition to the Calendar view displays the current weather and forecast for a key location 
without leaving Outlook. 

Conclusion 

With features that make your day-to-day work easier, there’s a lot to like about the new Microsoft Out-
look 2013. While it packs in quite a few updates, you should have no trouble getting accustomed to it because 
most of the menus, options, and tools behave like earlier versions of Outlook. You’ll soon discover Outlook is 
more flexible than ever, allowing you to work more productively, and from just about anywhere.  

 

(Continued from page 8) 
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Microsoft Word: How to Add a Watermark to a Word Document 

 

 

 

 

 

 

Many Microsoft Word documents are a work in progress requiring multiple reviewers and edits before they 
are final.  

What if you want to more clearly indicate a file is a draft or confidential? Would it be a neat look to add 
your company logo as a background image to each page in a Word document? Whether you want to add 
text or an image, the solution is to insert a watermark in Word. 

Adding background text or even an image is easy with the watermark feature in Microsoft Word. Word 
even includes a gallery of ready-made watermarks or you can create your own custom watermark. It’s also 
simple to add a background color or picture to your document. 

 

Create a Watermark: 

To insert a watermark in Word: 

 

1. In Microsoft Word, select the Design tab. 

2. Choose Watermark (in the Page Background group). 

3. Select from a group of common options including CONFIDENTIAL, DRAFT, URGENT  
or pick Custom Watermark to add a graphic or your own customized text watermark. Word also  
includes the option to download additional watermarks from the Microsoft Office website. 

4. Next pick a picture or text watermark and then build your custom watermark from the choices in the 
dialog box. Your options include formatting text, font, color, and even the direction of the text 
(diagonal or horizontal). 

5. Experiment with the Washout (picture watermark) or Semitransparent (text watermark) options 
which lighten the watermark to make the text on top easier to read. 

6. For text watermarks, a bold or thick sans-serif font (no flourishes or font “tails”) such as Arial Bold, 
Calibri or Verdana is often more readable than a serif font like Times New Roman or Cambria. 

7. Pick Apply to preview your watermark. Choose OK to add the watermark to your document. 
 

Remove a Watermark: 

To remove a watermark in a document in Microsoft Word: 

 

1. Select the Design tab. 

2. Choose Watermark (in the Page Background group). 
3. Select Remove Watermark. 
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Remote PC Repair Scams 

 

This scam originates out of India, as victims are contacted by a phone call from scam artists claiming to be 
a representative of a high-tech computer firm.  

The call is a warning to the victim that their computer has been infected or could be under a threat of being 
infected by a vicious malware virus that will severely damage their internal operating system. The alleged 
"representative" encourages the victim to go online and allow them to troubleshoot the computer. This will 
help to fix all of the related issues immediately. The representative will use this time to infect the computer 
with a malware virus that will do severe damage to the internal operating system and force the owner to go 
to a third-party website to confirm the damage.  

The goal of this scam is to force the computer owner to immediately pay for unnecessary repair work over 
the phone by using a credit card or by using Google Play Cards or Apple Gift Cards.   First, never give any-
one remote access to your computer, as you should hire a local repair service whenever possible. It is rare 
that a PC representative would call a computer user to alert them of a virus threat. Unfortunately, too many 
individuals have fallen for this scam and often report their personal identity has been stolen soon after the 
phone encounter.  

No legitimate corporation will ever accept Google Play Cards or Apple Gift Cards as payment. Many of our 
residents have fallen victim to these types of scams. 

  

Another Scam that has been targeting our residents is the Social Security Administration Scam.  

There has been a significant uptick in fraudulent telephone calls from people claiming to represent the  
Social Security Administration (SSA). In them, unknown callers threaten victims that they face arrest or 
other legal action if they fail to call a provided phone number or press the number indicated in the message 
to address the issue.  

Sometimes the scammers switch tactics and say that they want to help an individual activate a suspended 
Social Security number. 

They may even "spoof" the actual Social Security hotline number to appear on the recipient's phone: 1-800-
772-1213. If you receive one of these calls, hang up. 

 Know that Social Security rarely contacts persons by phone unless you have ongoing business with them 
and they never make threats about arrest or legal action.  

Report suspicious calls to the SSA Office of the Inspector General by calling 1-800-269-0271. 

Please be aware and do not trust anyone who contacts you by phone and threatens to take legal action if you 
do not comply.  
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10 Ways to Select Text in Microsoft Word 

 
 

My Word mantra is “Select Then Do” because most formatting and editing actions in a document require 
that text is selected first before applying a change such as adding bold or copying a paragraph. 
  
Knowing easy ways to select text in Microsoft Word is key to simplifying your work. 
 
Editing & Formatting Shortcuts 

 
Try these shortcuts to quickly select text in Microsoft Word with your mouse and keyboard. 
 
Selecting Any Text: 

· Point to beginning, click-and-drag. 

· Or, click at beginning of text, then press and hold down [Shift] and click at end of text. 

· Or, move to the beginning of text, press and hold down [Shift] and press directional keys to move to 
the end of text. 

· Or, click at the beginning of text, press [F8] (Extend Selection), move the mouse pointer to the end of 
the desired selection, and click the mouse. 

 
Word: Double-click anywhere in the word. 
 
Sentence: Hold down [Ctrl] + click anywhere in the sentence. 
 
Beginning of line: From current position, hold down [Shift] and click at the beginning of the line or 
press [Home] to move to the beginning of the line. 
 
End of line: From current position, hold down [Shift] and click at the end of the line. 
 
Non-contiguous blocks of text: Hold down [Ctrl] and drag to select each section of text. 
 
Line: Click once in selection bar.* 
 
Multiple lines: Click and drag in the selection bar to the left of the lines.* 
 
Paragraph: Double-click in selection bar * or triple-click anywhere in the paragraph. 
 
Entire document: Triple-click in the selection bar * or press [Ctrl] and click in selection bar.* 
 
* The selection bar in the left margin is the area at the left edge of the screen where the pointer changes to 
an arrow pointing up and to the right. 
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Use Your Computer to Write a Memoir 
 

By Keith Connes, Member, The Computer Club, FL 
September 2018 issue, The Journal of The Computer Club, Inc. 
www.scccomputerclub.org/ 
diane (at) scccomputerclub.org 
 
 
Here’s a way to use your computer to create a legacy: Write a memoir. It doesn’t matter whether you are a 
beginning writer or a seasoned pro – or even if you don’t consider yourself to be a writer at all. Write a mem-
oir to present the gift of your inner self to your family, friends, and perhaps a wider audience. You might find 
that you’ve acquired a new hobby! 
 
A memoir can give your loved ones a greater insight into who you are and how you got to become the person 
you are – your thoughts, your feelings, your adventures through life, and the things you learned along the way.  
 
Let me be clear as to what I mean by “memoir.” Some people may think of that word “memoir” as meaning an 
autobiography. Well, yes, an autobiography is a very extensive memoir, taking in the entire life of the subject, 
but a memoir can also be just a small nugget of that person’s existence – a series of reminiscences, or even a 
single recollection. So, it’s not that daunting a task. 
 
Even so, would your memoir really be that valuable to others? Well, think of somebody who is important to 
you, be it a spouse, relative, or friend – and even though you’ve known that person for years, you sense that 
there are aspects of her or his life that you don’t know about and wish you did. Not necessarily skeletons in 
the closet, but – well, wouldn’t it be fun to know that Mom always wanted to be a trapeze artist, but somehow 
never got around to it? 
 
My best friend since high school was, for most of his adult life, a sales executive whose high-powered drive 
enabled him to start up and run several insurance companies. I thought I knew him pretty well, but I was 
astonished when he sent me a book of sensitive and lovely poetry that he had written! I saw an aspect of Frank 
I had never suspected, and my respect and admiration for him became even greater. 
 
Well, you may not be a secret poet, or even a wannabe trapeze artist, but aren’t there some unrevealed parts of 
you that you wouldn’t mind sharing, but you haven’t gotten around to it, or maybe you’re just a little shy 
about it? 
 
Write it down. Write your memoir. One of the easiest ways to get it done is to use speech recognition software 
(some of it is free) and possibly a compatible recorder. The software automatically converts your spoken 
words into a text file, such as Microsoft Word or Google Docs.  
 
Here are a few basics about getting comfortable with the dictation process: Just start talking and don’t worry 
about grammar or punctuation – you can fix it later. If it would help get the thoughts flowing, sit down with 
someone you feel relaxed with and record the conversation as you chat about a topic for your memoir.  
 
Regardless of where your memoir begins, it can take on a life of its own – because it is, after all, the life of 
your own. 
 
Write your memoir. Do it for the ones you love, for yourself, and maybe for some great-great-grandchildren 
you will never know. But through your memoir, they will get to know you.  
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Store Your Recipes in Word 
 

By Jerry Heaton, Editor, Central Kentucky Computer Society 
October 2018 issue, CKCS Newsletter 
www.ckcs.org  
jerheat (at) outlook.com 
 
I had a dear sister-in-law named Margaret, now deceased, who never owned a computer, probably because I do 
not think she ever typed anything. Just the same, my older brother, more than once, suggested that she buy a 
computer to join the modern world. Finally, she asked, “What would I use one for?” Searching for a quick re-
sponse, he said, “You could keep your recipes on it”. This brought a huge laugh from her and the rest of the  
family as well. Margaret seldom ever cooked, either.  
 
This story came to mind when a classmate said she had found a recipe online for pumpkin nut bread. She wanted 
to save it. She did not know how to move it to her computer and wondered if there was a computer program for 
recipes. There may be one, but I told her how I organize my favorite recipes in my computer – I keep them all in 
a simple Word document titled “RECIPES”.  
 
I offered her these step-by-step instructions.  
 
1. If you have not already done so, create a document named RECIPES.  
 
2. Go to the web site and find your recipe.  
 
3. Using the mouse, click and drag to highlight only the recipe. Be sure you start at the top left edge of the recipe, 
and then drag until what you have is only the recipe. (A better way to highlight is to click at the start of the reci-
pe, hold down the CONTROL + SHIFT keys and use the four arrow keys to highlight exactly what you want to 
save and nothing else).  
 
4. Press Control + C and that copies the highlighted text to your clipboard.  
 
5. Take what you have copied (it is on your clipboard) and paste it into your word document by pressing  
 Control + V.  
 
6. Edit your recipe text – maybe making the title bold and a bit larger than the rest of the text.  
 
7. Save the word document. It is now among your favorite recipes. I put each recipe on a separate page by putting 
a “page break” at the bottom of the recipe (create a page break by holding down the control key and tapping the 
ENTER key once). This provides you a blank page on which to put your next recipe.  
 
When I want to use a recipe, I just print that one page; thereby, I have a fresh copy to follow as I cook. If I spill 
something on the recipe, that is no problem because I generally discard those sheets and just reprint them the next 
time I am ready to use that recipe another again. Give this a try.  
 
By the way, it is easy to improve a recipe on your master document for the next time.  



Gazette June 2019     www.PPCUGinc.com                                                    Page 15 

PLATEAU PC USERS GROUP, Inc. 

APPLICATION FOR MEMBERSHIP 

  

          ____ New Member                    ____ Renewing Member 
  

  

Return this application, with check for annual dues payable to "PLATEAU PC USERS GROUP." Return to the club 
Treasurer during our meeting or mail to PPCUG Treasurer. P.O. Box 3787, Crossville, TN 38557. Our annual dues are 
now payable on July 1st of each year.  Annual dues are $24 per single person / $30 per family starting 7/1/2014 with 
partial years’ dues as follows: 
 

 

 

Join In 
July-Sept 

Annual Dues 
Oct-Dec Jan-Mar Apr-June 

Single: $24 $18 $12 $6 

Families: $30 $22 $15 $7 

  

    

Date: ______________           Amount Paid: $ ____ :.00,  by Cash ___ , or    Check ( #_____________ ) 
                                                

    _____________________________________________ ________________________________  _____________________________________ 

          Last Name         First Name Family Members (if family membership) 

_______________________________________________________________________ 

           Address:  

____________________________          _____ _____________ (_____  )____________________ 

    City                        State     Zip Code Phone Number 

 
E-Mail address:  —————————————————————————————— 
 

 
I have belonged to a Computer Club before. Yes    _____    No _____ _ 
 
l have used PCs since (year):   __________     
 
I have knowledge in the following areas that I would be willing to share with club members:  
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
______________________________________________________________________________ 
 
 
January 2019 
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Note:  Please see page #15 for the Plateau PC Users Group, Inc. Application for Membership form. 

July 2019 

Sun Mon Tue Wed Thu Fri Sat 

 1 2 . 3 2:00 P.M. 

PPCUG Board 
Mtg. 

4 5 6 

7 8 9 6:00 P.M. 

General Mtg.  
Presentation. 
Followed By 
Q&A Session 

10 11 12 13 

14 15 16 17 18 1:00 P.M. 

Plateau Pho-
tography Club 
Workshop 
Mtg. 

19 20 

21 22 23 24 25 26 27 

28 29 30 31    


